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1. Vigtigt

Denne elektroniske brugervejledning er beregnet
til alle, der bruger Philips-skaermen. Tag den tid du
behgver for at leese vejledningen, inden du bruger
skaeermen. Den indeholder vigtige oplysninger om

bemaerkninger angaende brugen af din skeerm.

Philips garanti deekker under forudsatning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formal i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og vedligeholdelse

) Advarsler

Anvendelse af kontrolelementer, justeringer eller
fremgangsmader, der ikke er beskrevet i denne
dokumentation, kan resultere i elektrisk stad,
elektriske ulykker og/eller mekaniske ulykker:
Lees og felg disse vejledninger, nar du tilslutter og
anvender din computerskarm.

Betjening

*  Skaermen skal holdes veek fra direkte sollys,
savel som meget kraftigt lys og andre
varmekilder: Leengere udsattelse for disse
typer omgivelser kan medfgre affarvning og
beskadige skaermen.

* Fjern alt, der kan risikere at falde i
ventilationshullerne eller forhindre korrekt
afkaling af skeermens elektronik.

*  Bloker ikke ventilationshullerne pa kabinettet.

*  Ved placering af skaermen skal du sikre dig,
at det er let at komme til stremstikket og
stikkontakten.

*  Hvis der slukkes for skeermen ved at fierne
stremkablet eller jeevnstremsledningen, skal du
vente 6 sekunder, for du saztter stremkablet
eller jevnstremsledningen til igen for at opna
normal betjening.

*  Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

*  Udsat ikke skaermen for kraftige vibrationer
eller sted under anvendelse.

»  Sla ikke pa skaermen, og tab den ikke under
brug eller transport.

Vedligeholdelse

*  Som en beskyttelse af skeermen skal du undga
at trykke kraftigt pa skeermpanelet. Nar du
flytter din skeerm, sd tag fat om rammen for at
lzfte den; laft ikke skeermen ved at sztte din
hand eller fingre pa skeermpanelet.

* Tag stikket ud fra skeermen, hvis du ikke skal
bruge den i en leengere periode.

* Tag stikket ud at kontakten til skeermen, hvis
du skal renggre den med en let fugtet klud.
Skeermen kan terres af med en ter kiud,
nar der er slukket for strgmmen. Under alle
omsteendigheder, ma der ikke bruges organiske
oplasningsmidler til renggring af din skaerm.

» For at undga risiko for elektrisk sted eller
permant beskadigelse af anleegget, sa ma du
ikke udseette skaermen for stev, regn, vand eller
miliger med hej fugtighed.

¢ Huvis din skeem bliver vad, skal den terres af
med en ter klud sa hurtigt som muligt.

*  Hvis der kommer fremmed substans eller vand
ind i skaeermen, s sluk straks for stremmen og
tag stikker ud. Fjern derefter den fremmede
substans eller vandet, og send skaermen til
servicecenteret.

*  Skermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* For at opretholde den bedste ydelse af din
skaerm og for langvarig brug, sa brug skeermen
et sted, der er indenfor fglgende temperatur-
og fugtighedsomrade.

o Temperatur: 0-40°C 32-95°F
o Fugtighed: 20-80% RH



Vlgtlge oplysninger om burn in/skyggebillede
Serg altid for at aktivere en pauseskarm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskarm eller et andet program, der
opdaterer skaeermen regelmaessigt, hvis du
viser statisk materiale i lengere perioder.
Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage, at det
“breendes fast” pa skaermen, dvs. de sakaldte
“spogelsesbilleder” pa din skaerm.

» Fastbreending” og "spagelsesbilleder”
er velkendte faenomener inden for
skeermpanel-teknologien. “Fastbreending” og
""spagelsesbilleder” forsvinder oftest gradvist
efter en vis periode, efter skaeermen er slukket.

) Advarsel

Hvis du ikke aktiverer pauseskermen eller
regelmeessigt opdaterer skeermbilledet kan det
medfere symptomer pa “burn-in", “after-image”
eller “skyggebillede”, der ikke forsvinder og ikke
kan repareres. Ovennavnte skader er ikke daekket

af garantien.

Service

* Kabinettet ma kun abnes af kvalificeret
servicepersonale.

*  Huvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
"Kundeinformationscenter")

* For oplysninger om transport, se "Tekniske
specifikationer™.

» Efterlad ikke din skaerm i en bil/bagagerum
under direkte sollys.

& Bemzrkning

Kontakt en servicetekniker; hvis skeermen ikke
fungerer korrekt, eller hvis du er usikker pa, hvad
du skal gare, nar betjeningsinstruktionerne, der er
givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Folgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forsigtighedsregler og advarsler

| hele denne vejledning kan tekstblokke vaere
ledsaget af et ikon og std med fed eller kursiv
skrift. Disse blokke indeholder bemaerkninger og
punkter; hvor der skal udvises forsigtighed, eller
advarsler. De anvendes som falger:

© Bemarkning

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

@O Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab af
data.

) Advarsel

Dette ikon angiver risiko for personskader og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater og
er eventuelt ikke ledsaget af et ikon. | sadanne
tilfelde er den givne udformning af advarslen
lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og emballage

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please

visit wwwi.philips.com/about/sustainability/recycling.



E1 Installation af stander

2. Ops=tning af skaerm

1. Anbring skeermen med forsiden vendt nedad
pa en blad og jeevn overflade, og veer forsigtig
med ikke at ridse eller beskadige skeermen.

2.1 Installation

El Emballagens indhold

PHILIPS

2. Set basen ind i VESA monteringsomradet.

Audio (optional) VGA (optional)




E Tilslutning til PC

PHILIPS

o
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o
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Kensington anti-tyverisikring
VGA-indgang

DVI-D input

Display port

Lydindgang

AC strgmindgang
Nulstremkontakt

USB downstream

USB upstream
Oretelefonstik

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skeermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skaermens signalkabel til videostikket
bag pa computeren.

Forbind pc-lydkablet til lydstikket bag pa
computeren.

Saet computerens og skaermens
netledninger til et stik i neerheden.
Forbind USB skaermens upstream-port
og pc'ens USB port med et USB kabel.
Downstream-porten er nu klar til enhver
USB tilslutning.

Teend for computeren og skarmen. Hvis
skaermen viser et billede, er installationen
gennemfort.

2.2 Brug af skaerm

/<

/v ERGO/A /0K [0)

| | I |
(4] e o

El Produktbeskrivelse set forfra

@ (O |Forattende og slukke for skeermen.

© | ©/0K |Sidan far du adgang til OSD-menuen.

© | AV [Sidanjusteresi OSD.

[ 4 I ErgoSensor:

© | 1 |Tilindstilling af skaermens lydstyrke.

0 < ga; S lii\g,zaz I' det forrige
Smartlmage. Der kan vaelges mellem
seks indstillinger: Office (Kontor),

@ | ) Photo (Bilede), Movie (Film), Game

(Spil), Economy (@konomi) og Off
(Slukket).




F1 Beskrivelse af OSD-skarmen

Hvad er OSD (On-Screen Display)?

Visning pa skaermen [On-Screen Display

(OSD)] er en funktion pa alle Philips skeerme.
Den satter en slutbruger i stand til at justere
skaermindstillingerne, eller vaelge skaermens
funktioner direkte via et instruktionsvindue pa
skaermen. Et brugervenligt skaermvisningsinterface
vises som nedenfor:

. On 3
ErgoSensor _
off .

Demo

Input

Picture

Grundlzggende og enkle anvisninger til
kontrolknapperne

Pa OSD-skaermen, der er vist ovenfor, kan brugere
bruge v a-knapperne pa skaermens frontkant til at
bevage cursoren med, OK for at bekrafte et valg
eller en eendring.

OSD-menuen

Nedenstaende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende den
som opslag, nar du senere skal orientere dig i de
forskellige justeringer.

Main menu

Input

Picture

Audio

Color

Language

OSD Settings

Setup

Sub menu

— ErgoSensor E

DVI (available for selective models)

DisplayPort (available for selective models)

Picture Format — Wide screen, 4:3, 16:9, 1:1
Brightness ~ — 0~100

Contrast — 0~100

SmartContrast — On, Off

Gamma — 18,20,22,24,26

OverScan ~ — On, Off

Stand-Alone  — On, Off

Mute — On, Off

DP Audic ~ — DP, Audio In (available for selective models)
Color Temp. —— 5000K, 6500K, 7500K, 8200K, 9300K, 11500K
sRGB

User Define Red: 0~100
E Green: 0~100
Blue: 0~100

English Espafiol, Frangais, Deutsch, ltaliano,

Portugués, Pycckui, {45

r— Horizontal — 0~100
Vertical — 0~100
Transparency — Off, 1,2,3,4
OSD Time out — 5,10, 20, 30, 60
Auto
Power LED — 01234
H. Position — 0~100
V. Position — 0~100
Phase — 0~100
Clock — 0~100
Resolution Notification —  On, Off
Reset — Yes, No

Information



2. Opsatning af skerm

El Meddelelse om oplgsning

Denne skaerm er designet til optimal ydelse ved
dens naturlige oplasning: 1920%1080 ved 60Hz.
Nar skaermen bruger en anden opla@sning, ses
felgende advarsel pa skeermen: Brug 1920x1080
ved 60Hz for at opnd det bedste resultat.
Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i OSD
(skermmenuen).

B Fysisk funktion

Vip

Drej

Hejdejustering

Tap




2.3 Fjern standeren og foden © Bemzrkning
Denne skarm accepterer et 100mm x 100mm

El Fjernelse af foden VESA-kompliant monteringsinterface.
) P g
Betingelse:
*  For standard montering af VESA PHILIPS
100mm
1. Udtreek standeren til dens maksimale hgjde. 4 S
100mm
N D G
- o _

2. Anbring skeermen med forsiden vendt nedad
pa en jeevn overflade, og veer forsigtig med ikke
at ridse eller beskadige skeermen. Laft derefter
skeermens stander.

3. Udlgs standerens las og treek standeren veek fra
fodsgjlen.




3. Optimering af billede

3.1 Smartlmage

El Hvad er dette?

Smartimage er forvalgte indstillinger; der
optimerer skaermen i henhold til indholdet, og
som realtid dynamisk indstiller lysstyrke, kontrast,
farve og skarphed. Uanset om du arbejder

med tekstprogrammer, ser billeder eller ser
video, sa giver Philips Smartlmage den optimale
skaeermydelse.

El Hvorfor behgver jeg det?

Du gnsker en skeerm, som giver det bedste billede

for alle typer indhold. For at @ge skaeerm-oplevelsen,
indstiller Smartlmage-softwaret dynamisk lysstyrke,

kontrast, farve og skarphed i realtid.
El Hvordan virker det?

Smartlmage er en eksklusiv, ferende Philips-
teknologi, som analyserer indholdet pa skaermen.
Ud fra det valgte scenarie forbedrer Smartlmage
dynamisk billeders og videoers kontrast,
farvemaethed og skarphed for at forbedre det
viste billede — alt i realtid og blot med et tryk pa
en knap.

EJ Hvordan aktiveres Smartlmage?

1. Tryk pd B for at starte Smartlmage pé
skarmen:

2. Fortszt med at trykke pa B for at skifte
mellem Office (Kontor), Photo (Foto), Movie
(Film), Game (Spil), Economy (@konomi) og
Off (Fra).

3. Smartlmage ses pa skeermen i fem sekunder;
men du kan ogsa trykke pa OK for at
bekrefte.

4. Nar Smartlmage er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge sRGB
skal du deaktivere Smartlmage med [E foran
pa skeermen.

Udover at bruge @ til at rulle ned med, kan du
ogsa trykke pa w A for at veelge og derefter trykke
pa OK for at bekreefte valget og derefter igen
lukke Smartimage OSD.



Der kan veelges mellem seks tilstande: Office
(Kontor), Photo (Foto), Movie (Film), Game (Spil),
Economy (@konomi) og Off (Fra).

@ Smartimage

Office

Photos

Game

Economy

Off

Office (Kontor): Forbedrer teksten og
daemper lysstyrken for at @ge laesbarheden

og nedsatte anstrengelsen af gjnene. Denne
tilstand @ger afggrende leesbarheden og
produktiviteten, ndr der arbejdes med
regneark, PDF filer, skannede artikler og andre
generelle kontorprogrammer.

Photo (Foto): Denne profil kombinerer
farvemaethed og dynamisk kontrast og skarphed
for at vise billeder og lignende overordentlig
klart og i levende farver — alt uden synlige fejl i
det indskannede billede og blegnede farver.
Movie (Film): Viser hver detalje i videoernes
markere omrader med gget luminans,

dyb farvemaethed, dynamisk kontrast

og barberbladsagtig skarphed og uden
farveudvaskning i de lysere omrader og opnar
pa denne made dynamiske, naturlige vaerdier
med henblik pa den ultimative videovisning.
Game (Spil): Aktivér overdrive-kredslgbet for
at fa den bedste reaktionstid, reducere skeeve
kanter for genstande, der bevager sig hurtigt
pa skeermen, forbedre kontrastforholdet for
lys og marke. Denne profil giver spillere den
bedste oplevelse af spil.

10

Economy (@konomi): Med denne profil
indstilles lysstyrke og kontrast, ligesom
baggrundslys fintunes for at opna det rette
billede til hverdagens kontorprogrammer.
Nedsat strgmforbrug.

Off (Fra): Ingen optimering med Smartlmage.

3.2 SmartContrast

El Hvad er dette?

Unik teknologi, der dynamisk analyserer det viste
indhold og automatisk optimerer en skarms
kontrastforhold til maksimal visuel klarhed.

Den @ger baggrundsbelysningen og giver et
klarere, friskere og lysere billede eller deemper
baggrundsbelysningen med henblik pa en tydelig
visning af billeder pa merk baggrund.

E1 Hvorfor behover jeg det?

Du gnsker den allerbedste visuelle klarhed

og visning ved enhver type indhold. Smart-
kontrast styrer dynamisk kontrast og indstiller
baggrundslyset, sa det giver klare, friske og lyse
spil- og videobilleder og viser tydelig, leesbar tekst
ved kontorarbejde.Ved at nedseette skermens
stremforbrug, sparer du energiomkostninger og
forleenger skaermens levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid for at indstille farver

og baggrundslysets intensitet. Denne funktion
forbedrer dynamisk kontrasten og giver saledes en
bedre underholdningsoplevelse, nar du ser videoer
eller spiller spil.



3.3 SmartSaturate

El Hvad er dette?

Smart-teknologien, der styrer farvemathed — dvs.
graden, med hvilken én skeermfave sammenblandes
med nabofarverne — giver rige og livlige billeder
sa du kan opleve bedre underholdning, nar du ser
videoer.

E1 Hvorfor behover jeg det?

Du gnsker rige og livlige billeder for mere
underholdning og sjov, nar du ser billeder og
videoer.

El Hvordan virker det?

SmartSaturate kontrollerer dynamisk farvemaethed,
graden som skarmens farver sammenblandes
med nabofarverne, for at kunne gengive rige,
livlige billeder for bedre underholdning nar du

ser billeder eller videoer i skeermtilstanden Movie
(Film) eller Game (Spil). Funktionen er deaktiveret
for visning af kontorprogrammer i topkvalitet, samt
i tilstanden Economy (@konomi) for at reducere
stremforbruget.

I

3.4 SmartSharpness

El Hvad er dette?

Smart-teknologien, som @ger skarpheden, nar du
behgver den til ultimativ billedydelse og mere
underholdning og sjov, nar du ser videoer og
billeder.

E1 Hvorfor behgver jeg det?

Du gnsker den ultimative skarphed for mere
underholdning og sjov, nar du ser billeder og
videoer.

El Hvordan virker det?

Smart-teknologien @ger skarpheden, nar du
behgver den, til ultimativ billedydelse og mere
underholdning og sjov, nar du ser videoer og
billeder i tilstanden Movie (Film) eller Game
(Spil). Funktionen er deaktiveret for visning

af kontorprogrammer i topkvalitet, samt i
tilstanden Economy (@konomi) for at reducere
stremforbruget.



3.5 Philips SmartControl Premium

Det nye SmartControl Premium-software fra
Phillips giver dig mulighed for at kontrollere
skaeermen via et nemt, grafisk interface.
Komplicerede justeringer hgrer fortiden til.
Dette brugervenlige software guider dig gennem
finindstilling af opl@sning, kalibrering af farve,
justeringer af clockning/fase, RGB-hvidpunkt osv.

Udstyret med den seneste teknologi i algoritmer
for hurtig behandling og reaktion, er denne
igjnefaldende, ikon-baserede software, der ogsa er
Windows 7 parat, klar til at forbedre din oplevelse
med Philips-skeermel!

El Installation

Felg instruktionen og fuldfer installationen.
Du kan starte, nar installationen er fuldfgrt.
Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS

o philps.comiweicome

Monitor driver and software installation

Monitor driver

ssn, Portguese, Smplifed Chinese

12

Guide for forste start

» Efter installation af SmartControl Premium
abnes guiden automatisk, nar du abner
programmet fgrste gang.

Guiden leder dig trin for trin gennem indstilling
af skeermen.

Du kan ogsa ga til Plug-in menuen for at starte
guiden pa et senere tidspunkt.

| Standard-ruden kan du indstille flere
funktioner uden guide.

] smartControl Premium X

SmartContro| Premium PHILIPS

Wizard

e your display 0 get the most.
You to use the simple
 Start Wizard button.
This process nvol f steps that wi let you
tune your dsplay and save the settngs.

1. Choose the Start Wizard button.

2. Follow the steps outined n this process.

You

Adjust Preferences

3. Save your settngs for future u
Audio

—

Color Auto Pivot

-
Tnput

B

Eco Power ward

2
resets
e\
Thefe Decerence
|

SmartDesktop

L 3y

Help Start Waard




F1 Start med Standard-rude CEEEERES B 2w
SmartControl Premium PHILIPS
Adjust menu (Indstillingsmenu): Focus
*  Med "Adjust” ("Indstilling”-)menuen kan
du indstille Brightness (Lysstyrke), Contrast
(Kontrast), Focus (Fokus), Position (Position)
og Resolution (Oplasning).

Your display's timing needs to be synchronized with
the video signal.
1. Choose Auto Set
2. i verscolbonde s sl veble youl need
to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest settng to minmize
movement on the screen.

Brightness.
* Foretag indstillingen ved at folge
. : = &
instruktionerne. 23 = *
. “Focus Phase 49
* Installationen kan annulleres med Cancel co Power = +
(Annuller). =5 o e ) mwsw
(] SmartControl Premium S o G
Premium
SmartControl Premu PHILIPS
‘
Brightness sy
\d Sropeiy s Biiksem viiest flon &
detail in darker image areas. Adjust the Brightness for
the best possble picture qualty.
Adiust 2. Raise the Brightness to the desired level .
2 o e e e e
o caualseparton of the supes. smarConwotpremiom B ¥
‘&) Premium
\g schenes SmartControl PHILIPS
Color
Position
s the Position buttons to center the image on
AR your display. usvvg this tool, you can postion the image
~ up, down, lef
Focus Brightness 99 o 1. Use ’he Up/Down buttons to center the image
Power - fjust.
o = oW G e LRt utons o cntrthe e
- < - Undo - - Reset
‘Options Color
n!ap Eco Power

undo Reset.

)

Resolution
Options
Premium
SmartControl PHILIPS
Contrast Yeb
Adjust the Contrast (use the sider) to keep detais in
e
Sy ———
g
Adiust 2. Slowly lower the Contrast to make the
e e -
Shouldreman baro vebe, (&] smartConrol Premiom [
3 Premium
\g o SmartContro| Fremu PHILIPS

Resolution
Contrast.
You are currently t a Preferred resolution. For your
disply to show crsp, dear text, colors, and images,

2B
A oue G shols b st 01 Pl e

:

Focus e o
Sukiat IF your dispay s at 2 Non-Preferred resoluton, cick
on'the Preferred button to change your resokiton to
Preferred

Eco Power -

Postion

g

I™ 4:3 3spect ratio

Adiust
% Undo Reset Y ¥ Enable Resoluton Notiier
Resolution — Brghtness Picture Format
Color

Optons

Contrast
AR
ol
Focus

Vel Eco Power
» Postion
sy F
\E Resoluton

Optons

Help

13



Farvemenu:

Med "“Color” (“Farve”-)menuen kan du
indstille RGB, Black Level (Sortniveau), White
Point (Hvidpunkt), Display Gamma (Vis
gamma), Color Calibration (Farvekalibrering)
og Smartimage (se afsnittet Smartlmage).
Foretag indstillingen ved at felge
instruktionerne.

Se nedenstaende oversigt med
undermenupunkter baseret pa dit input.
Eksempel pa Color Calibration
(Farvekalibrering).

(] smartControl Premium S @
Premium
SmartControl PHILIPS

RGB
Al displayed colors are produced by mixing Red, Blue,
and Green at different brightness levels. Choosing a
s o et oo
prefer to adjust the RGB now, folow these steps:

Adjust 1. Adjust the intensity of the Red, Green, and

Blue using the slder bars.
NOTE: Changing the RGB values can adversely effect
the dplayed colors.
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White Point

- White Point i the pont 3t which equal combinations
of red, green, and blue Ight at ful ntensty create
whte. Ths effects the overal color qualty. For the
most accurate colors cick the Reset button then

Adiust select the White Pont.
1. Rlease select the White Point vakie for the best

5 . " sble color qualty.
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Display Gamma

Gamma s 2 component f the el bighness n 2
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Calibration

Your diplay needs to be properly calibrated in order
for & to produce the widest range of colors accurately.
Calibration should always take place 3s the it tunng
step in the process. Remember to recalbrate any time

‘you make indwidual adjustments to image quaity or
Adjust
whenever you move your display to a new location.
= l 1. Make al other necessary adjustments to image
1l acaey .
RGB 2. Press Show Me to leam how to use the
calbration toos.
"I 3. Finaly, press Start to begin the calibration
process.
Color Back Level
' Enable color caibration
Color software designed in collaboration with Joseph
Holmes
whte point Protectad by U, Patent No. 6,686,953
Eco Power Display Gamma
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“Show Me" (“Vis Mig") starter vejledningen i
farvekalibrering.

“Start” — starter 6-trins farvekalibrerings-
sekvensen.

“Quick View" (“Quick-visning") indlaeser for/
efter-billederne.

For at vende tilbage til “Color” (“Farve”-)

2

startruden, skal du klikke pa "“Cancel” (“Annuller”

Aktiver farvekalibrering — der som standard
er aktiveret. Hvis markeringen er fiernet, kan
der ikke ske farvekalibrering, ligesom start- og
quick-visning knapperne er gratonede.

Der skal vaere patent-oplysninger pa
kalibreringsskaermen.



Forst farvekalibreringsskaerm:

*  “Previous” (“Foregdende’-) knap er
deaktiveret, indtil den anden farveskarm.

* “Next” (“Naste”) gér til efterfalgende mal
(seks mal).

e “Final next” (“Afsluttende Neeste”) gar til
File > Presets (File > Forvalg) rude.

*  “Cancel” (“Annuller”) lukker Ul og vender
tilbage til “plug in" siden.

Smartlmage

Smartimage — tillader brugeren at endre
indstillingen for at opna en bedre skaermindstilling
baseret pa indhold.

Nar der indstilles pa “Entertainment”
(“Underholdning”), aktiveres SmartContrast og
SmartResponse.
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Power Savigs
Schedule Power Savings.

SmartPower

PHILIPS

Power Savings

Use these settings to save power consumption. Power
@n be saved by decreasing the brightness of the
backght.

Master Backiight Brightness

Use the sider to adjust the brightness of the backlght.
Lower percentage of brightness wil s less watts of

Use Preset
Further power savings can be realzed by decreasing
the backight based on lghting condttions. Select the
percentage of the backight brightness for your ighting

Bright Room————————————————————
25 50 C 75% @ 100

Dim Room
[ -

Master Backlght Brightness
= oW

100%

Bright Now Dim Now.

“Tum Power Off Now.

Theft Deterence (Anti-tyveri)-ruden er kun aktiv,
nar tilstanden Theft Deterence (Anti-tyveri) er
valgt i Plug Ins-rullemenuen.
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SmartImage

Smartimage optmaes your disply for dfferent screen
image content. Make a selection that matches the
content.
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Preferences
Audio
Color Auto Pivot
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Theft Deterrence

‘Theft Deterrence is currenty Disabled. To enable
Theft Detarrence, enter your PIN i the box below,
then cick Accept.

Enter PIN to enable Theft Deterrence:

Reenter PIN to verfy:

Time before disply is disabled (minutes) 60
= o

Accept Cancel



For at aktivere Theft Deterence (Anti-tyveri), skal
du klikke pa tilstanden Enable Theft Deterrence

(Aktiver Anti-tyveri), hvorefter folgende skaerm ses:

*  Der kan kun indtastes en PIN-kode pa fra fire
til ni cifre.

* Nar PIN-koden er indtastet, leder “Accept”
("Accept’-) knappen brugeren til pop-op
dialogboksen pa falgende side.

*  Minimum-minutter er fem. Skyderen star som
standard pa 5.

¢ Kreever ikke, at skeermen forbindes til en anden
veert for at ga i tilstanden Theft Deterrence
(Anti-tyveri).

AE— T

SmartControl Premium PHILIPS

Theft Deterrence
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Nar der er oprettet en PIN-kode, indikerer *Theft
Deterrence” ruden, at “Theft Deterrence” er
aktiveret og giver PIN-kode funktionsknap:

*  “Theft Deterrence Enabled” ("“Anti-tyver
Aktiveret") ses.

* Tilstanden Disable Theft Deterrence
(Deaktiver Anti-tyveri) dbner rudeskaermen pa
naeste side.

*  PIN-kode Funktioner knappen virker kun, nar
brugeren har oprettet PIN-kode. Knappen
abner sikkert PIN-kode websted.
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“Options > Preferences” (“Funktioner >
Indstillinger”) — er kun aktiv, nar Preferences
(Indstillinger) er valgt i “Options” ("‘Funktioner’-)
rullemenuen-rullemenuen. Pa en ikke-understettet
skeerm med DDC/Ci er kun “Help” (“Hjeelp”) og
“Options” (“Funktioner™) til radighed.

<] smartCantrol Premium 20X

SmartControl Premium PHILIPS

Preferences

Color

L

Help

* Viser nuveerende, foretrukne indstillinger:

* Funktionen aktiveres ved at afmaerke feltet.
Afmarkningsfeltet er en flip-flop.

*  “Enable Task Tray” (“‘Aktiver Jobbakke")
menuen er som standard afmaerket (Til)
pa skrivebordet. Menuen Enable Context
(Aktivér kontekst) viser valgmulighederne i
SmartControl Premium for Select Preset
(Veelg Forvalg) ogTune Display (Indstil Display)
i genvejmenuen ved hgjreklik pa skrivebordet.
Disabled (Deaktiveret) fierner SmartControl
Premium fra kontekst-genvejsmenuen.

*  “Enable Context” (“Aktiver Indhold"-)

menuen er som standard afmaerket (Til)

pa skrivebordet. Menuen Enable Context
(Aktiver Indhold) ger, at systembakkens ikon
for SmartControl Premium vises. Et hgjreklik
pa jobbakke-ikonen viser menufunktionerne
for“Help” (“"Hjeelp”") og Technical Support”
(“Teknisk Statte™). Afmeerk for “Upgrade”
("Opgradering”),"About” (“*Om’) og “Exit"
(“Afslut™). Nar “Enable Task Tray” (“Aktiver
Jobbakke™) menuen er deaktiveret, viser
jobbakke-ikonen kun EXIT (AFSLUT).



e “Run at Startup” (“Ker ved Startop”) er “Options > Audio” (“Funktioner > Lyd”) — er

som standard afmarket (Til). Nar den er kun aktiv, nar “Volume" (“Lydstyrke”) er valgt i
deaktiveret, starter SmartControl Premium “Options” (“Funktioner’-)rullemenuen.

ikke ved starten og ikonet vises ikke i Pa en ikke-understgttet skeerm med DDC/Ci er
systembakken. SmartControl Premium kan kun “Help” ("Hjeelp"") og “Options” (*“Funktioner’)

kun startes fra genvejen pa skrivebordet eller  til radighed.
fra programfilen. Intet forvalg, indstillet til at

e p—— 2

kere ved startop, indlaeses, ndr denne boks

ikke er afmaerkeF’z (er deaktiveret). StrereCionns] ~= PHILIPS
Aktivér gennemsigtighedstilstand (Windows 7, B o o

Vista, XP). Standard er 0% uigennemsigtighed. \d ;::;illm DP——
“Options > Input” (“Funktioner > Indgang”) — \5 ido
er kun aktiv, ndr “Input” (“Indgang”) er valgt i Coor e 0
"Options” (“Funktioner”-)rullemenuen. Pa en ikke- -
understgttet skeerm med DDC/Ci er kun “Help” \E’Ep‘fm; b
(“Hjeelp™) og “Options” (“‘Funktioner”) til radighed. 3 P
Alle andre faneblade i SmartControl Premium er \!g =
ikke il radighed. o 5 B
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SmartControl Premium PHILIPS = e
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Your display has multiple inputs (connections on back
of this dispiay)
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h
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Presats

Display Port
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*  Vis"Source” (“Kilde") instruktionsruden og
nuveerende indgangskilde indstilling. optons s
*  Ved enkeltindgangsskeerme ses denne rude
ikke.

SmartDesktop

®

Help 180° 270°
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“Help > User Manual” (“Hjzlp > Context Sensitive (Indholdssensitiv) menu

Brugervejledning”) — er kun aktiv, nar “User “Context Sensitive” (““Indholdssensitiv”’) menuen
Manual” (“Brugervejledning”) er valgt i “Help” er som standard aktiveret. Hvis “Enable Context”
("Hjeelp”-)rullemenuen. Pa en ikke-understattet (“Aktiver Indholdssensitiv'") menuen er afmeerket
skeerm med DDC/Ci er kun “Help” (“Hjeelp”) og i “Options > Preferences” (“Funktioner >
“Options” (“Funktioner”) til radighed. Indstillinger”) ruden, ses menuen.

 sarcone i 2% Smartcontl [ ——

SmartControl Premium % PHILIPS W

Tice e —

aption to fil ut an Assstance Form.
g Photo

Adiust You can ko choose to have information about your
software automaticaly attached to the assstance
form. You'l need o be online to use this feature. Game

ﬂ Economy
user Manual

“Context” ("Indhold”) menuen har fire punkter:
*  SmartControl Premium — ndr valgt, ses

Movie

Update

Display D

o oner g “About” (*Om") skaermen.

s i *  “Select Preset” (“Velg Forvalgt™) — en
\g - hierakisk menu med gemte forvalg, der
— straks kan bruges. En afkrydsniong viser
\g det i gjeblikket valgte forvalg."Factory

e _vernd | Techswor Preset” (“Fabriksforvalg”) kan ogsa hentes i

rullemenuen.
* Tune Display (Indstil Skeerm) — dbner

“Help >Version” (“Hjzlp > Version”) — er kun kontrolpanelet for SmartControl Premium.
aktiv, nar “Version” ("Version”) er valgt i “Help” *  Smartlmage — Kontrollér aktuelle indstillinger
("Hjeelp"-)rullemenuen. P4 en ikke-understattet for Office (Kontor), Photo (Foto), Movie (Film),
skeerm med DDC/Ci er kun "Help” (“Hjaelp”) og Game (Spil), Economy (@konomi) og Off (Fra).
"Options” (“Funktioner”) til radighed.

s B

SmartControl Premium PHILIPS

Version

SmartControl

Version .10 dtune-p-R2011-08-15-113318

DDC/CI Communicat

Adjust Copyright © 1993

Portratt Displays, Inc.

User Manual
Coor a

Update

Diplay D
System D
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“Task Tray” (“Jobbakke”-) menu aktiveret
Menuen i systembakken kan ses ved at hgjreklikke
pa SmartControl Premium-ikonet i systembakken.
Et venstreklik starter programmet.

Help

Technical Support
Check for Update
About

Exk

Jobbakken har fem punkter:

*  "Help” ("Hjeelp") — adgang til brugervejledning-
fil: Abner Brugervejledningen med standard
browservinduet.

*  “Technical Support” (“Teknisk Hjalp™) — viser

siden med teknisk hjeelp.

"“Check for Update " ("Tjek for

opdateringer”) — leder brugeren til PDI

Landing og tjekker brugerens version i forhold

til den allernyeste version.

*  "About” (“Om”) — viser detaljerede
referenceoplysninger: Produktversion,
frigivelses-information og produktnavn.

*  Exit (Afslut) — Luk SmartControl Premium
Hvis du vil kere To run SmartControl Premium
igen, skal du enten vaelge SmartControl
Premium i programmenuen, dobbeltklikke pa
skrivebordet eller genstarte systemet.

PHILIPS

SmartControl Premium

SmartControl
Version 2.10
dhune-plp-R2011-08-15-1133-18
Copyright © 1993-2011 Portrait Displays, Inc.
Patents Pending
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“Task Tray” (“Jobbakke”-)menu deaktiveret

Nar “Task Tray” (“Jobbakke) er deaktiveret

i indstillinger-mappen, er kun valg af "EXIT”
("AFSLUT") til radighed. Hvis du helt vil fierne
SmartControl Premium fra systembakken, skal du
deaktivere “Run at Startup” (“Ker ved Startop”)

i “Options > Preferences” (*Muligheder >
Indstillinger”).

© Bemarkning

Alle illustrationer i dette afsnit er kun

beregnet som reference. Softwareversionen af
SmartControl kan a@ndres uden varsel. Tjek altid
det officielle Portrait-websted www.portrait.com/
dtune/phl/enu/index for at downloade den seneste
softwareversion af SmartControl.



3.6 Guide til SmartDesktop

El SmartDesktop

SmartDesktop er en del af SmartControl
Premium. Installér SmartControl Premium og velg
SmartDesktop fra Options (Indstillinger).

(] smartControl Premium @
SmartControl Premium PHILIPS
SmartDesktop
Adjust Preferer
\’ Audo Vertical Horizontal
Coor Auto sk 2] o
a2 = R
EROwED Weard Right Vertical Left Vertical
oyl a
2
3 & presets [ =
= E\ Bottom Horzontal Top Horzontal
Options Theft Deterrence
smartDeskiop off
Hep. Identdy

»  Afkrydsningsfeltet Align to partition (Tilpas
til afsnit) vil aktivere automatisk tilpasning af
vinduet nar det traekkes til det definerede
afsnit.

*  Velg det gnskede afsnit ved at klikke pa ikonet.
Afsnittet anvendes pa skrivebordet og ikonet
fremhaeves.

* Identify (Identificer) giver mulighed for hurtigt
at vises gitret.
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Bl Trek og slip vinduer

Nar afsnittene er konfigurerede og du har
valgt Align to partition (Tilpas til afsnit), kan du
treekke et vindue ind i regionen og det tilpasses
automatisk. Nar vinduet og musemarkgren er
inden i regionen, fremhazeves regionen.

© Bemark

Hvis regionens yderkant ikke er synlig nar du
treekker vinduet, er indstillingen “Vis indhold i
vindue, mens der traekkes” deaktiveret. Sadan
aktiveres indstillingen:

1. Klik pa System i Kontrolpanel.

2. Klik pa Avancerede systemindstillinger (i Vista

og Win7 findes denne indstilling i venstre

sidelinje)

| afsnittet Ydelse, klik pa Indstillinger.

4. Marker afkrydsningsfeltet Vis indhold i vindue,
mens der treekkes, og klik pa OK.

w

Anden alternativ sti:

Vista:

Kontrolpanel > Personlige indstillinger >
Vinduesfarve og -udseende > klik pa "Abn klassisk
visning for at fa flere farveindstillinger" > klik pa
knappen "Effekter” > marker Vis indhold i vindue,
mens der traekkes

XP:
Egenskaber for skeerm > Udseende > Effekter.. >
MarkerVis indhold i vindue, mens der traekkes

Win 7:
Ingen anden alternativ sit tilgeengelig.



El Valgmuligheder i titellinje

Desktop Partition kan abnes fra titellinjen i et
aktivt vindue. Det giver en hurtig og nem made at
styre skrivebordet pa, savel som en metode til at
sende et vindue til et afsnit pa, uden traek og slip.
Flyt markeren over pa det aktive vindues titellinje
for at fa adgang til rullemenuen.

B Hgjreklik-menu

Hajreklik pa ikonet for Desktop Partition for at
vise rullemenuen.

Find Windows »
Desktop Partition  »
Identify Partition

Align Off

Exit -
{ B Snagit 5 [[Window

1. Find Windows (Find vinduer) — | visse tilfeelde
har du muligvis sent flere vinduer til det
samme afsnit. Find Window (Find vinduer)
viser alle dbne vinduer og flytter det valgte

vindue gverst.
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2. Desktop Partition — Desktop Partition viser
det valgte afsnit og giver dig mulighed for at
skifte til et andet afsnit, vist i rullemenuen.

. o Wos# B = %
e v i nony 0
= — el ]
" ASBMCDE AaBbCel | AEmOM
- o o g
s &
<]
SmartDesktop Guide g
1 ktop ~ SmartDesktop is in SmantControl Premium. Install SmartControl Premium and select E
SmantDesktop from Options. i
[l SmartControt Premiom @
SmartControl Premium PHILIPS

© Bemark

Huvis der er tilsluttet mere end én skarm, kan
du vaelge malskaermen for at skifte afsnittet.
Det fremhaevede ikon representerer det aktive
afsnit.

3. Identify Partition (Identificer afsnit) —
Viser gitret for det aktuelle afsnit.

4. Align On/Align Off (Tilpas til/fra) — Aktiverer/
deaktiverer den automatiske tilpasningsfunktion
ved traek og slip.

5. Exit (Afslut) — Lukker Desktop Partition og

Display Tune. Du kan genstarte Display Tune
fra startmenuen eller genvejen pa skrivebordet.



B Venstreklik-menu A Hojreklik i systembakke

Venstreklik pa ikonet for Desktop Partition for Systembakkens ikon indeholder ogsa de fleste
hurtigt at sende det aktive vindue til et afsnit uden  funktioner, understgttet af titellinjen (med
treek og slip. Nar du slipper med musen, sendes undtagelse af at sende et vindue til et afsnit).

vinduet til det fremhaevede afsnit.

Identify Partition
Align Off

Bright Light
Dim Light

Help

Technical Support
Check for Update
About

Exit

*  Find Windows (Find vinduer) — | visse tilfelde
har du muligvis sent flere vinduer til det
samme afsnit. Find Window (Find vinduer)
viser alle abne vinduer og flytter det valgte
vindue gverst.

*  Desktop Partition — Desktop Partition viser
det valgte afsnit og giver dig mulighed for at
skifte til et andet afsnit, vist i rullemenuen.

* Identify Partition (Identificer afsnit) —Viser
gitret for det aktuelle afsnit.

* Align On/Align Off (Tilpas til/fra) — Aktiverer/
deaktiverer den automatiske tilpasningsfunktion
ved treek og slip.
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Definitioner for SmartDesktop afsnit

Navn
Full Desktop (Hele
skrivebordet)

Beskrivelse
Anvender alle indstillinger pa hele skrivebordet.

Billede

Vertical (Lodret)

Vurderer skaermopl@sningen og opdeler skaermen i to lige
store, lodrette regioner.

For 90/270 bevares lodret konfiguration.

B

Horizontal (Horisontal)

Vurderer skaermopl@sningen og opdeler skaermen i to lige
store, vandrette regioner.

For 90/270 bevares vandret konfiguration.

Vertical Triple (Lodret
tredobbelt)

Vurderer skeermoplasningen og opdeler skaermen i tre lige
store, lodrette regioner.

For 90 afsnit, 1 vandret topafsnit, 2 vandrette midterafsnit,
3 vandrette bundafsnit.

For 270 afsnit, 3 vandrette topafsnit, 2 vandrette
midterafsnit, 1 vandret bundafsnit.

Vertical Split Left
(Lodret opdeling,
venstre)

Vurderer skeermoplasningen og opdeler skeermen i to
lodrette regioner, venstre side er en enkelt region, hajre
side er opdelt i to lige store regioner.

For 90 afsnit, 1 pa topafsnittet og 2 og 3 nederst.
For 270 afsnit, 1 pa bundafsnittet og 2 og 3 @verst.

Vertical Split Right
(Lodret opdeling, hgjre)

Vurderer skaermoplasningen og opdeler skarmen i to
lodrette regioner, hgjre side er en enkelt region, venstre
side er opdelt i to lige store regionen

For 90 afsnit, 1 og 2 pa topafsnittet og 3 nederst.
For 270 afsnit, 3 pa topafsnittet og 1 og 2 nederst.
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Navn
Vandret opdeling, top

Beskrivelse

Vurderer skaermopl@sningen og opdeler skaermen
vandret i to lige store regioner: Topregionen er enkelt, og
bundregionen er opdelt i to lige store regioner

For 90 partition 1 i hejre side, lodret partition 2 og 3 i
venstre side, lodret.

For 270 partition 1 i venstre side, lodret partition 2 og 3 i
hgjre side, lodret.

Billede

Vandret opdeling, bund

Vurderer skaeermoplasningen og opdeler skeermen vandret
i to lige store regioner. Bundregionen er enkelt, og
topregionen er opdelt i to lige store regioner

For 90 partition 1 og 2 i hgjre side, lodret partition 3 i
venstre side, lodret.

For 270 partition 1 og 2 i venstre side, lodret partition 3 i
hgjre side, lodret.

Lige opdeling

Vurderer skaermoplasningen og opdeler skaeermen i fire lige
store regioner.

24




4. ErgoSensor

Philips ErgoSensor er en innovativ teknologi, der forteller brugere om, hvordan de skal sidde
ergonomisk korrekt ved computeren. Den bruger en indbygget sensor i skeermen, der fgler og maler
brugerens adfeerd i forhold til tilstedeveerelse, holdning og brug og giver tilbagemelding om, hvordan det
kan geres bedre.

Genvejstast

Indstilling
Du kan tende/slukke for Philips ErgoSensor og aktivere
demotilstanden med en knap pa skeermrammen.

Demotilstand

ErgoSensor-skaermen har en indbygget demotilstand, der viser

dig, hvordan registreringen og meddelelsessystemet fungerer.
Aktiveringsmetode: (A) 15 graders nakkehaldning til vinkelregistrering.
(B) 3 min. til pauseaktivering. (C) > 90 cm og < 70 cm til
afstandsaktivering,

Hvordan fungerer det?
*Visningsafstand

Hvis brugeren ikke sidder inden
for den optimale ergonomiske
zone pa 70 - 90 cm, genereres en
meddelelse.

* Visningsvinkel

Hvis brugerens holdning registreres med en
nakkehzldning over 15 grader, genereres en
meddelelse.

* Visningstid

Hvis brugeren registreres som vaerende foran
computeren i mere end én time, genereres en
pamindelse om pause.

* Energispare

A. Bruger registreres i stol, skeerm fungerer normalt

B. Hvis bruger ikke registreres i stol, vil skeermens lys-
styrke blive deempet efter 1 min. Energibesparelse

C. Skaerm slukker efter 3 min., og gar i standby-tilstand og
sparer strgm

D. Bruger vender tilbage til stol. ErgoSensor returnerer
skaermen til normal drift med det samme.
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5. Tekniske specifikationer

Skeermpanel-type TFT-LCD
Baggrundslys LED
Panelstgrrelse 24"W (61,0 cm)
Aspektforhold 16:9

Pixel pitch 0,277 x 0,277 mm
Lysstyrke 250 cd/m?
SmartContrast 20.000.000:1
Kontrastforhold (typisk) 1000:1
Reaktionstid (typisk) 5ms

Optimal oplgsning

1920 x 1080 ved 60 Hz

Synsvinkel 170° (H) / 160° (V) ved C/R > 10

Billedforbedring Smartlmage

Skaermfarver 16,/ M

Vertikal opdateringshastighed 56 Hz - 76 Hz

Horisontal frekvens 30 kHz - 83 kHz

sRGB JA

Signalinput DVI-D (digital), VGA (analog), Display port

USB USB 2.0 x 4

Inputsignal Separat synk, synk. pd gren

Lyd ind/ud Pc-lyd ind, hovedtelefon ud

Indbyggede hgijttalere 15W x 2

Brugerfunktioner ED/< (/v ERGO/A /0K )
OSD sprog Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk

og portugisisk

Andre funktioner

VESA montering (100 x 100mm), kensington-Ias

"Plug & Play" kompatibilitet

DDC/CI, sRGB, Windows 7/Vista/XE Mac OSX, Linux

Vip -5/+20
Drej -65/+65
Hegjdejustering 130mm




Tendt-tilstand

259W (typisk), 48, 2W (maks.) (med lyd og USB x 4)

Stremdiode

Teendt-tilstand (DKO-tilstand) 12,3W

(typisk)

Energiforbrug AC AC AC

(EnergyStar 5.0 testmetode) indgangsspaending indgangsspzending indgangsspaending
ved ved ved
100VAC +/- 5VAC, [ 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz

Normal funktion (typisk) 21,57W 21,44W 21,42W

Sovetilstand (typisk) 0,1W 01W 01W

Fra oW oW oW

Varmetab* AC AC AC
indgangsspaending indgangsspaending indgangsspeending
ved ved ved
100VAC +/- 5VAC, | 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz

Normal drift 73,62BTU 73,17BTU 7311BTU

Sovetilstand (typisk) 0,34BTU 0,34BTU 0,34BTU

Fra OBTU OBTU O0BTU

Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Produkt med fod (BxHxD)

Indbygget, 100-240VAC, 50/60Hz

565 x 518 x 220mm

Produkt uden fod (BxHxD)

565 x 352 x 55mm

Kassemal (BxHxD)

605 x 442 x 252mm

Produkt med fod 6,35kg
Produkt uden fod 4,2kg
Produkt med emballage 8,8kg

Temperaturomrade Oplagring: -20°C til 60°C
Drift: 0°C til 40°C
Relativ fugtighed 20% til 80%
Hgjde Ikke drift: + 40.000 ft (12.192 m)
Betjening: + 12.000 ft (3.658 m)
MTBF 30.000 timer
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ROHS JA

EPEAT Guld (www.epeat.net)
EnergyStar 5.0

Emballage 100% genbrugelig

Specifikke stoffer

Myndighedernes godkendelser

Farve

PVC BFR-fri hus

BSMI, CE Mark, FCC Class B, GOST, SEMKO, TCO Certified Edge,
UL/cUL, 1ISO9241-307, TUV-GS, TUV-Ergo

Sort/Salv

Finish

Struktur

(=) Bemarkning

1. EPEAT Gold eller Silver er kun gyldig hvor produktet registreres af Philips. Ga til www.epeat.net for

registeringsstatus i dit land.

2. Disse data kan andres uden meddelelse derom. Ga til www.philips.com/support for at hente den

seneste version af brochuren.




5.1 Oplesning og forvalgte indstillinger

El Maksimal oplgsning

1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)

El Anbefalet oplgsning

1920 x 1080 ved 60 Hz (digital indgang)

3147 640x480 59,94
37,88 800x600 60,32
48,36 1024x768 60,00
54,00 1152x864 60,00
44,77 1280x720 59,86
47,78 1280x768 59,87
49,70 1280x800 59,81
60,00 1280x960 60,00
63,89 1280x1024 60,02
47,71 1360x768 60,02
5547 1440x900 59,90
55,94 1440x900 59,89
75,00 1600x1200 60,00
64,67 1680x1050 59,88
65,29 1680x1050 59,95
66,59 1920x1080 59,93
74,04 1920x1200 59,95
67,50 1920x1080 60,00

(=) Bemarkning

Bemaerk, at skeermen fungerer bedst med den
indbyggede oplasning pa 1920 x 1080 ved 60 Hz.
Folg den anbefalede opl@sning for at opna den
bedste billedkvalitet.
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6. Stromstyring

6.1 Automatisk energispare

Huvis der er installeret et VESA DPM overholdende
skaeermkort eller software pa pc'en, kan skaermen
automatisk nedsatte stremforbruget, nar den
ikke bruges. Nar input fra tastatur, mus eller
anden input-enhed registreres, "vagner" skaermen
automatisk igen. Nedenstaende tabel viser denne
automatiske energisparefunktions stremforbrug og

signalering:

VESA tilstand| Video |V synk| Lsynk | Forbrugt strem | Diodefarve
Aktiv TIL Ja Ja | 259W (typisk), | Hvid
48,2W (maks.)
(med lyd og
USB x 4)
Sovetilstand FRA Nej Nej 01W Hvid
(typisk) (blinker)
Kontakt Fra FRA - - ow FRA

Den felgende opsatning bruges til at male
skaermens stremforbrug.

Indbyggede oplgsning: 1920 x 1080

Kontrast: 50%

Lysstyrke: 250 nits

Farvetemperatur: 6500k med fuldt, hvidt menster
Lyd og USB inaktiv (fra)

=) Bemarkning
Disse data kan andres uden meddelelse derom.
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7. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe
to use throughout its life cycle.

TCO Certified Edge

Congratulations,

edge,
' Your display is designed for both
you and the planet!

The display you have just purchased carries the
TCO Certified Edge label. This ensures that your
display is designed, manufactured and tested
according to some of the strictest quality and
environmental requirements in the world. This
makes for a high performance product, designed
with the user in focus that also minimizes

the impact on the climate and our natural
environment.

This display is awarded the TCO Certified cutting
edge mark to signify it incorporates a new cutting
edge innovation that delivers distinct benefits for
the user and reduced impact on the environment.
TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO Certified
represents one of the toughest certifications for
displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

. Good visual ergonomics and image quality
is tested to ensure top performance and
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reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, color
and luminance uniformity, color rendition
and image stability

. Product have been tested according to
rigorous safety standards at an impartial
laboratory

. Electric and magnetic fields emissions as low
as normal household background levels

. Low acoustic noise emissions

Some of the Environmental features of the TCO
Certified for displays:

. The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001)

. Very low energy consumption both in on-
and standby mode minimize climate impact

. Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury and
lead (RoHS compliance)

. Both product and product packaging is
prepared for recycling

. The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com



EPEAT

(Www.epeat.net)
7% The EPEAT (Electronic Product
Environmental Assessment Tool)
& program evaluates computer
desktops, laptops, and monitors
based on 57 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.
EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)
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2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on ISO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for Environment
Labeling of Ergonomics, Energy, Ecology and
Emission, TCO: Swedish Confederation of
Professional Employees) for TCO versions

Energy Star Declaration

(www.energystar.gov)
H As an ENERGY STAR® Partner, we
M have determined that this product

meets the ENERGY STAR® guidelines
for energy efficiency.

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

€& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

e

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.
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Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de facon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
sighaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, I'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre |'équipement et
le récepteur.

* Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
* Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as described in EN 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following appliss to
davicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of the
davics is obliged to take all stape necessary to remove sources of infarfersnce 1o tela-
communication or other devicss.

Pulmdnan[nutrpmémmw poditade uvadeno, Ze spadé do do ffidy A podie EN 55022,

spada automaticky do tfidy B podie EN 55022, Pro zafizeni zafazend do tidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-li k rudanl telekomunikatnich nebo
Pnych zafizeni je ufvatel povinnen provést takowd opatfgnl, aby neSeni odstranil.




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Uszadeende powlnno byt zasilane 2 goiaeds 2 preybgceonym obwodem ochronmym (gniaedo
kotkiem). Wsj pdixdacnjatc i 40y wndxcma (lmlpulcr oo, drukaumpowmlw by mnam

fezerwana achr
e

wyjad wiveak kabla
asiliuce 2 gmiszdh, Widrt powiano enjdwat sie ' Poblizu urzadzénia 1 by iiwo dostgpne.

z_mk bepieceetsiwa “B” potwiendzs spodnost urssdzenia 2 wynsiganami beepieceefsiva
owalti zawartyil w PN-U3T-42107 | J’\ BOAIG2E]

Pozostale instrukcje bezpieczenstwa

*  Nie alezy wywad wiyezek sdapierowych lub wuwat kelka abwodu achrornega 2 wiyeek
Jezeh Loumc/nc-Jm [remy |m:\Jquaua 1 maledy whyé preediuzacea 3-avlowega 2

ymi warostami lub spad-
ranins dogasenees Ioh

i
alona kablach sysiemu komputerowego, sraz aby Kable nie
se toina byloby na tic nadeptywat Iul potyksé sig o tie

lory oalewad aapos and iy plynin m,um«.mp nerawy.
Nie nalciy wpychaé zudnych p .

® Systom kompureroyy pnmlmllmajdnwaf sig 2 dala o
st sty . N u..me
rpriteTa W ciasym miegsc be
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILFORSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)

HelaEiERCEE |




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schiden
durch Réntgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Rontgenverordnung erfiillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildrohre nur eine bauartgleiche
eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhdhte Augenbelastung bei zu geringem
Zeichenkontrast waéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

(A

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.
HEABIROHS

REFEXRE (AFEETRSREHERNE) (BIRAPEAMHRHS)
LAFHESIH T A RFa R ENEEE RV RS T ANE RIS E

ERIBBLIR
2R% (HRECRT)

ARGENRLTE
B ARGEHRNTHE
@ & # it SREE | SR_ER
(Po) | (Ho) | (Cd} | (CrB+) (PEB) (PBDE)
Shis [¢] [8] [6] [8] €] O
CRIBFR x [o] 6] [8] (€] O
WRBRR/TE] X x ] [8] €] O
R AR A x [9] ) [8) @] [e)
RRERE x [9] ) [8] @] O
RRRAERSR | x [®) ) [8] [S] [s]
* AR DEDRRRERIALATBNA N0 R - Rk TERY
O RTAABEENEERNATE IR BiSE
SRR AN TR ETRRE R SRR RERAT
X TR R R TERAN M S R A R
(BT ERTREAFHENGNERERGL) SENRRER | BE CRET X" 0k
AARARHSHNER (RTHRLOD)

@ FORAT TR

PEARIRERIIIR CH4) , P E R
A7 IAT BEAT 55 W) R BOG 3R A IE A (0 A%
AR KRAESNMECRAR, S R R
A 2 B A5 R AN R A B 3 ™
QesOR LN B o I 3 1™ T4 PR ST BR o

rhEREFRIEAR A
RBREAM (SERNRFATERNE) FRTHREFSUTER

HER N (cd/W) | > 1.05
BERIZF LD 140
RERUTE GB 21520-2008

PAE RS RIEE AR EAEWARIAR : http://www.energylabel.gov.cn/

(EFaaRmFrmel B EB L&A RR1%i%m

AT EFHRBERFRIPIR, AR FBREL R
FWLILR, HETFERETT R T mE IR E
BEN, BEZAEHAEFERINA R EYAIEEE R &
BEATEI AR



8. Kundeservice og garanti

8.1 Philips' regler ved pixeldefekter pa
fladskerme

Philips tilstreeber at levere produkter af den hgjeste
kvalitet.Vi anvender nogle af branchens mest
avancerede produktionsprocesser og udferer en
streng kvalitetskontrol. En gang imellem er defekte
pixler eller sub-pixler pa TFT skeermpaneler dog
uundgaelige. Ingen producent kan garantere,

at alle paneler vil vaere fri for pixeldefekter,

men Philips garanterer, at enhver skaerm med

et uacceptabelt antal defekter repareres eller
udskiftes under garantien. Dette notat forklarer de
forskellige former for pixeldefekter og definerer
de acceptable defektniveauer for hver type. For
at veere berettiget til reparation eller udskiftning
under garantien skal antallet af pixeldefekter pa

et TFT skaermpanel overskride disse acceptable
niveauer: For eksempel ma hgjst 0,0004% af sub-
pixlerne pa en skeerm veere defekte. Desuden
seetter Philips endnu hgjere kvalitetsnormer for
visse typer eller kombinationer af pixeldefekter;
derer mere generende end andre. Denne
pixelpolitik geelder i hele verden.

subpixel subpixel

v
(il B

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af tre
sub-pixler med primeerfarverne red, gren og bla.
Ndr mange pixler settes sammen, kan de danne et
billede. Nar alle sub-pixler i en pixel lyser, fremstar
de farvede sub-pixler tilsammen som enkelt hvid
pixel. Hvis de alle er marke, fremstar de tre farvede
sub-pixler tilsammen som en enkelt sort pixel.
Andre kombinationer af oplyste og merke sub-
pixler fremstar som enkelte pixler i andre farver

subpixel

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa skeermen
pa forskellige mader. Der er to kategorier af
pixeldefekter og flere typer sub-pixeldefekter i
hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels eller
underpixels, der altid lyser eller er "pa". Det vil
sige, at en lys prik er en underpixel, der fremstar
pa skermbilledet, nar skaermen viser et markt
meanster. Der er felgende typer defekte lyse
prikker:

En teend red, gren eller bld sub-pixel

I @

To sammenliggende tendte sub-pixler:
Rad + Bla = Lilla

Red + Gregn = Gul

Grgn + Bla = Cyan (Lysebla)

Tre sammenliggende teendte pixler (en hvid pixel)
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€& Bemarkning

En red eller bld lys prik skal veere mere end

50 procent lysere end de omkringliggende prikker,
mens en gren lys prik er 30 procent lysere end de
omkringliggende prikker:

Defekte mearke prikker

Defekte marke prikker fremkommer som pixels
eller underpixels, der altid er merke eller "fra". Det
vil sige, at en lys prik er en underpixel, der fremstar
pa skaermbilledet, nar skeermen viser et merkt
megnster. Der er felgende typer defekte merke

prikker:

Textliggende pixeldefekter

Da pixel- og sub-pixeldefekter af samme type,
der ligger teet pa hinanden, kan vaere mere
igjnefaldende, specificerer Philips ogsa tolerancer
for teetliggende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal et TFT skeermpanel i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,

der overskrider de tolerancer, der er gengivet i
folgende tabeller

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU

1 teendt sub-pixel 3
2 sammenliggende taendte sub-pixler 1
3 sammenliggende taendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU

1 merk sub-pixel 5 eller feerre
2 sammenliggende mearke sub-pixler 2 eller ferre
3 sammenliggende mgrke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller ferre

SAMLEDE DOT-DEFEKTER

Samlede bright- eller black dot-defekter af alle typer

ACCEPTABELT NIVEAU
5 eller faerre

=) Bemarkning

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1509241-307 (1ISO9241-307: Testmetoder for ergonomisk
krav, analyse og overensstemmelse for elektroniske skaerme til fremvisning)



8.2 Kundeservice og garanti

Kundeservice og garanti

For oplysninger om garantidaekning og geeldende stottekrav i dit omrade, bedes du besege

www.philips.com/support. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via nummeret

nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tIf Pris

Austria Siemens |1&S +43 0810 000206 €0.07

Belgium E Care +32 078 250851 € 0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Germany Siemens &S +49 01803 386 853 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tIf

Belarus NA IBA +37517 217 3386

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA Renoprom +385 1 333 0974

Czech Rep. NA Asupport 800 100 697

Estonia NA FUJITSU +372 6519900

Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Latvia NA “ServiceNet LV" Ltd. +371 7460399

Lithuania NA UAB "Servicenet" +370 7400088

Romania NA Blue Ridge Intl. +40 21 2101969

E—_— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)

e fegm NA KimTec doo. +381 1120 70 684

Slovakia NA Datalan Service +421 2 49207155

Slovenia NA PC H.and +386 1 530 08 24

U NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31

Turkey NA Techpro +90 212 444 4 832

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter Kundeservice tIf

Argentina Vermont 0800 3330 856

Brazil Vermont 0800-7254101

Kontaktoplysninger til NORDAMERIKA:

Land Callcenter ASC Kundeservice tlf

Canada Supercom Supercom (800) 479-6696

USA. TOS Teleplan (877) 835-1838

Kontaktoplysninger til Kina:

Kina

Kundeservice tlf: 4008 800 008




Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tIf
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | 1. - i Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
. . . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 273741116
T . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d}strlbutor and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
United Arab 5 AL SHAHD COMPUTER LLC {00971 4 2276525
Emirates
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA C Ltd +84 5113.562666 Danang City
S +84 5113.562666 Can tho Province
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9. Fejlfinding og FAQ

9.1 Fejlfinding

Denne side omhandler problemer, som kan klares
af brugeren selv. Hvis problemet stadig er der, efter
at du har prevet disse lgsninger, skal du kontakte
Philips's Kundeservice.

El Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller, at el-ledningen er anbragt i
stikkontakten og bag pa skarmen.

* Kontroller ferst, at stremkontakten foran pa
skeermen er i OFF (FRA) position og tryk den
derefter i ON (TIL) position.

Intet billede (stremdiode blinker hvidt)

* Kontroller; at der er teendt for computeren.

* Kontroller; at signalkablet er korrekt forbundet
til computeren.

* Kontroller, at der ikke er nogen bgjede stikben
i signalkablets tilslutningsende. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

*  Energisparefunktionen kan vare aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller; at signalkablet er korrekt forbundet
til computeren. (Se ogsa Hurtig start-
vejledningen).

* Tjek, om skeermkablets stikben er bgjede.

* Kontroller; at der er teendt for computeren.

AUTO (AUTOM.)-knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.

© Bemarkning
Den automatiske funktion er ikke n@dvendig i DVI
digital-tilstand.

Synlige tegn pa rog eller gnister

*  Forsag ikke at fejlfinde.

*  Treek straks skaermens stik ud af stikkontakten.

* Kontakt straks en repraesentant fra Philips
kundeafdeling.

E1 Billeddannelses-problemer

Billedet er ikke centreret

* Justér billedets position med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock (Fase/
Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.

Billede vibrerer pa skermen
» Tjek, at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.

Vandret flimren

“

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i USD hovedmenuen. Den kan
kun bruges i VGA-tilstand.

Billedet er slgret, uklart eller for merkt
* Indstil kontrast og lysstyrke i OSD.



Der forbliver et “efterbillede”,
“indbrandingsbillede” eller “spagelsesbillede”,
efter at der er slukket for stremmen

»  Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage,

at det “braendes fast” pa skeermen, dvs. de
sakaldte “spggelsesbilleder” pa din skaerm.
“Fastbreending” og “spagelsesbilleder” er
velkendte fanomener inden for skaermpanel-
teknologien. | de fleste tilfeelde forsvinder
“indbreending” eller “efterbillede” eller
“'spogelsesbillede” gradvist, efter at strammen
er sldet fra.

Serg altid for at aktivere en pauseskaerm, der
bevager sig, nar skaermen efterlades uden at
blive anvendt.

Serg altid for at aktivere et program, der
opdaterer skeermbilledet regelmaessig, hvis
skaermen viser indhold, der ikke skifter.

Hvis du ikke aktiverer pauseskeermen eller
regelmaessigt opdaterer skeermbilledet kan det
medfere symptomer pa “burn-in”, “after-image”
eller “skyggebillede”, der ikke forsvinder og
ikke kan repareres. Ovennaevnte skader er ikke
deekket af garantien.

Billedet er forvranget.Tekst er utydelig eller

sloret

* Indstil pc'ens skeermoplasning som skeaermens
anbefalede, native oplasning.

Der ses rgde, bld, merke og hvide pletter pa

skaermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag. Se
politikken om pixels for yderligere oplysninger.

“Tendt’-lyset er for kraftigt. Det forstyrrer
Du kan justere “Teendt"-lyset med Stremdiode
i OSD-menuerne.
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H Lydproblem

Ingen lyd

Kontrollér, om lydkablet er korrekt sluttet til
pc'en og skaermen.

Kontrollér, at lyden ikke er slaet fra. Tryk pa
OSD’ens “Menu”, vaelg “Audio” (Lyd) og
derefter “Mute” (Lyd fra). Marker i position
"Off” (Fra).

Tryk pa “Volume” (Lydstyrke) i OSD-menuen
for at justere lydstyrken.

Bl USB-problem

USB-tilsluttet udstyr fungerer ikke

Kontrollér, om USB upstream-kablet er
tilsluttet korrekt

Sluk for skeermen, og teend den igen. Det kan
vaere ngdvendigt at installere/geninstallere
USB-driverne pa din pc og sikre, at hubben er
aktiv.

Gentilslut det USB-tilsluttede udstyr

For yderligere hjelp, se venligst Forbruger-
informationscentre-listen og kontakt Philips’s
Kundeservice.



9.2 FAQ for SmartControl Premium

SP1.

Sv.:

SP2.

Sv.:

SP3.

Sv.:

Jeg har udskiftet skeermen pé en pc
til en anden skaerm, og nu fungerer
SmartControl Premium ikke laengere.
Hvad skal jeg gore?

Genstart din pc og se, om SmartControl
Premium fungerer nu. Eller skal du
afinstallere og geninstallere SmartControl
Premium for at sikre, at den korrekte driver
er installeret.

SmartControl Premium fungerede fint
tidligere, men nu virker programmet ikke
leengere. Hvad skal jeg gore!?

Hvis nogle af de felgende handlinger har

veeret udfert, skal skeermdriveren maske

geninstalleres.

* Videografikadapter er blevet udskiftet
med en anden

* Opdater videodriver

* Aktiviteter i OS som f.eks. servicepakke
eller programrettelse

* Opdater Windows og opdater skarm-
og/eller videodriver

*  Windows blev startet med skaermens
strom sldet fra eller afbrudt. For at finde
ud af det, skal du klikke pad “Denne
Computer” og derefter pa Egenskaber ->
Hardware ->Enhedsstyrer. Hvis du ser
"“Plug & Play skeerm’ under Skaerm, skal
du geninstallere. Afinstallér SmartControl
Premium og geninstallér det.

Efter installation af SmartControl Premium
sker der ingenting, selv om jeg klikker pa
fanen SmartControl Premium og venter,
eller der vises en fejimeddelelse. Hvorfor?

Det skyldes muligvis, at din grafiske adapter
ikke er kompatibel med SmartControl
Premium. Hvis grafikadapteren er en

af ovennavnte merker, skal du prove

at downloade den mest opdaterede
grafikadapterdriver fra det pageldende

44

SP4.

Sv.:

SP5.

Sv.:

firmas websted. Installer driveren. Afinstallér
SmartControl Premium og geninstallér det
igen. Hvis det stadig ikke virker, er vi bange
for; at grafikadapteren ikke understgttes.
Ga til Philips websted og kontrollér, om der
findes en nyere driver for SmartControl
Premium.

Nar jeg klikker pa “Product Information”
(“Produktinformation”), ses kun nogle af
oplysningerne. Hvad er der sket?

Det kan veere, at din grafikkortadapterdriver
ikke er den mest opdaterede version, som
fuldt ud understetter DCC/CI greenseflade.
Prov at downloade den mest opdaterede
grafikkortadapterdriver fra det pageeldende
firmas websted. Installer driveren. Afinstallér
SmartControl Premium og geninstallér det
igen.

Attention

Theft Deterence enabled

Jeg har glemt min PIN-kode til Theft
Deterence (Anti-tyveri) funktionen. Hvad
gor jeg!

Philips servicecenter forbeholder sig retten
til at bede om legitimation og godkendelse
for at kunne etablere skaeermens ejer.

Bemaerk, at tyverisikringsfunktionen er en
nyttig funktion, der falger med som gratis
ekstraudstyr. Ansvaret for styring af PIN-
koder ligger alene hos den individuelle
bruger eller organisationen, der opsatter
dem.

Huvis PIN-koden glemmes, kan Philips
servicecenter nulstille den for et mindre
gebyr efter verificering af ejerskab. Bemaerk,
at denne aktivitet ikke er daekket af standard
garantien.



SPé.

Sv.:

| en skeerm med Smartlmage-funktion
svarer sRGB-funktionen i farvens
temperaturfunktion i SmartControl
Premium ikke. Hvorfor?

Nar Smartlmage er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge
sRGB skal du deaktivere Smartimage med
E] foran pd skeermen.

45



9.3 Generelle FAQ

SP1:

Sv.:

SP2:

Sv.:

SP3:

Sv.:

Hvad skal jeg gore, hvis skermen under
installationen viser “Cannot display this
video mode” (“Kan ikke vise denne
videotilstand’)?

Den anbefalede oplasning for denne skaerm:

1920x1080 ved 60Hz.

* Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte fer.

* |Windows Start Menu, vaelg Indstillinger/
Kontrolpanel. | Kontrolpanel vinduet veelg
Skaerm-ikonen. | Egenskaber for Skaerm
vinduet valg “Indstillinger” fanebladet.
Under indstillinger; skub skyderen til
1920x1080 pixler.

+ Abn "Avanceret” og indstil
opdateringshastigheden pa 60Hz og klik
derefter pa OK.

» Genstart computeren og gentag trinene
2 og 3 for at bekreefte, at pc'en er
indstillet pa 1920x1080 ved 60Hz.

* Luk for computeren, frakobl den gamle
skeerm og genforbind Philips skeermen.

* Tend for skeermen og derefter for pc'en.

Hvad gor den anbefalede
opdateringshastighed for skermen?

Den anbefalede opdateringshastighed for
skaeerme er 60Hz. | tilfeelde af forstyrrelser
pa skarmen skal du sztte den op til 75Hz
og se, om dette fierner forstyrrelserne.

Hvad er .inf og .icm filerne pa cd-rom’en?
Hvordan installerer jeg driverne (.inf og
.icm)?

Dette er skaeermens driverfiler: Installer
driverne i henhold til brugervejledningens
anvisninger. Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om en
driverdisk, nar du installerer skeermen ferste
gang. Indsaet (medfelgende cd-rom) i pakken
i henhold til anvisningerne. Skaermdrivere
(.inf og .icm filer) installeres automatisk.
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SP4:

Sv.:

SP5:

SPé:

Sv.:

SP7:

Sv.:

SP8:

Sv.:

Hvordan justerer jeg oplgsningen?

Skeermkortet/grafikdriveren og skeermen
bestemmer sammen opl@sningerne til
radighed. Du kan vaelge den enskede
oplasning “Egenskaber for Skeerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg justerer
skermen?

S3 skal du blot trykke pa OK og derefter
valge “Reset” (“Tilbagestil”) for at ga tilbage
til de oprindelige fabriksindstillinger:

Er skeermen modstandsdygtig overfor
ridser?

Det anbefales generelt ikke at udsette
skaermens overflade for kraftige sted. Den
er beskyttet mod skarpe og stumpe ting.
Nar du handterer skaermen sa pas pa ikke
at trykke for kraftigt pa skeermens overflade.
Det kan pavirke garantibetingelserne.

Hvordan renger jeg skermens overflade?

Til normal renggring skal du blot anvende
en ren, blad klud.Til kraftigere renggring
skal du bruge isopropylalkohol. Brug ikke
andre oplgsningsmidler sdsom ethylalkohol,
ethanol, acetone, hexan osv.

Kan jeg &ndre skermens farveindstilling?

Ja, du kan &ndre farveindstillingen via OSD
pa felgende made:
e Tryk pa"OK" for at vise OSD (On

Screen Display)-menuen

* Tryk pa “Ned-pil” for at veelge
indstillingen “Color” (Farve), og

tryk derefter pd "OK" for at angive

farveindstillingen. Der er tre indstillinger;

som vist nedenfor.

1. Color Temperature
(Farvetemperatur) - de seks
indstillinger er 5000K, 6500K, 7500K,
8200K, 9300K og 11500K. Med



indstillinger i 5000K omradet virker
skeermen “varm’ med en rgd-

hvid farvetone, mens en 11500K
temperatur giver en “kold” bla-hvid
toning.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af
farver mellem forskellige enheder
(f.eks. digitale kameraer, skeerme
printere, skannere osv.)

3. Brugerdefiner - brugeren kan valge
sin foretrukne farveindstilling ved
at indstille den rgde, grenne og bla
farve.

& Bemark

Et mal for farven pa lys, der udstrales fra et objekt,
mens det opvarmes. Dette mal udtrykkes pd en
absolut skala (kelvingrader). Lavere kelvingrader
sasom 2.004K er rede, hgjere temperaturer sasom
9.300K er bla. Neutral temperatur, 6.504K, er hvid.

SP9:

Sv.:

SP10:
Sv.:

Kan jeg forbinde min skaerm til enhver pc,
arbejdsstation eller Mac?

Ja. Alle Philips skaerme er fuldt kompatible
med standard pc'er, Mac'er og
arbejdsstationer: En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skaermen til dit Mac-system.Vi anbefaler; at
du kontakter Philips salgsrepraesentant for
yderligere oplysninger.

Er Philips skaeerme “Plug & Play”?

Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX,
Linux.

SP11: Hvad er “billedklaebning” eller

Sv.:

“billedindbraending” eller “efterbillede”
eller “spogelsesbillede” pa skerme?

Uafbrudt visning af stille eller statiske
billeder over en lengere periode kan
fordrsage, at det ""breendes fast” pa skaermen,
dvs. de sdkaldte “spagelsesbilleder” pa din
skaerm. “Fastbreending”” og “‘spegelsesbilleder’
er velkendte fanomener inden for
skeermpanel-teknologien. | de fleste tilfeelde
forsvinder “indbreending’ eller “efterbillede”
eller “spagelsesbillede” gradvist, efter at
stremmen er slaet fra. Serg altid for at
aktivere en pauseskarm, der bevaeger

sig, nar skeermen efterlades uden at blive
anvendt.

Serg altid for at aktivere et program, der
opdaterer skeermbilledet regelmaessig, hvis
skaermen viser indhold, der ikke skifter.

) Advarsel

Hvis du ikke aktiverer pauseskermen eller
regelmeessigt opdaterer skeermbilledet kan det
medfere symptomer pd “burn-in", “after-image”
eller “skyggebillede”, der ikke forsvinder og ikke
kan repareres. Ovennavnte skader er ikke daekket
af garantien.
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SP12: Hvorfor viser skaermen ikke skarp tekst?

Sv.:

Hvorfor viser den forrevne tegn?

Skaermen arbejder bedst med sin native
oplasning pa 1920x1080 ved 60Hz.
Brug denne opl@sning for at opna det
bedste billede.



9.4 ErgoSensor FAQ

SP1:

Sv.:

SP2:

Sv.:

SP3:

Sv.:

SP4.

Sv.:

SP5:

Ans.:

SPé:

Sv.:

SP7:

Sv.:

Vil den fungerer, hvis jeg har kontaktlinser
pa, og hvad hvis de er farvede?

Ja.

Vil den fungere, hvis jeg har merke briller
pa af en arsag!

Nej. Der kraeves 2 x gjne for at vaere klart
synlig.

Vil den fungere, hvis jeg har briller med
styrke pa til lesning?

Ja, standard, klare briller med styrke er OK.
De kan genkendes, da dine gjne er synlige
gennem brillerne.

Hvad sker der, hvis jeg har “en klap for
ojet” af medicinske arsager?

Den vil ikke fungere korrekt. Der kraeves 2
x gjne for at kunne registreres til normal
funktion.

Fungerer den, hvis mit ansigt er delvis
dazkket af tej, hat osv?

Nar den bare kan klart kan registrere 2 x
gjne, sa fungerer den.

Hvis jeg leener mig fremad for at lese
noget pa skrivebordet, vil den fungere?

Nar bare fzleren kan kan registrere dine
@jne, sa fungerer den.

Fungerer den, hvis jeg har hat/hue/turban
pa hovedet?

Nar den bare kan klart kan registrere 2 x
gjne hele tiden, sa fungerer den.
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SP8:

SP9:

Sv.:

SP10:

Sv.:

SP11:

Sv.:

SP12:

Sv.:

SP13:

Sv.:

Hvad sker der, hvis jeg drejer skermen til
staende/90 graders tilstand?

ErgoSensor-funktionen vil automatisk
deaktivere, hvis du drejer skeermen. Den
fungerer kun i standard liggende tilstand.

Vil den fungerer, hvis jeg drejer skaermen
vaek fra ansigtet?

Nej. Du skal sidde med ansigtet mod
skeermen i standardposition foran skaermen.

Hvad sker derhvis jeg har 2 eller flere
kollegaer, der ogsa leser fra skaermen?

Den kan registrere mere end et ansigt,
men den vil "genkende" det ansigt, der er
direkte foran skeermen og teettest pa den,
og anser denne for at vaere hovedbrugeren.
Alle funktioner bliver aktiveret baseret pa
hovedbrugerens ansigt, som er registreret.

Hvad er den bedste afstand fra mine gjne
til skeermen?

80 cm er det optimale til komfortabel
leesning. Faleren vil fortaelle dig, hvis du
er over 90 cm og mindre end 70 cm fra
skaermen.

Hvad er den bedste halsvinkel for at opna
stressfri lesning?

Den bedste halsvinkel er "lige"! Hvis din
stilling registreres med en halsvinkel, der

er mere end 15 grader i et forudbestemt
tidsinterval, vil fgleren fortzelle dig, at du skal
rette dig ind.

Kan jeg ndre min timing vedrerende
pauser?

Nej. Den ideelle tid anses for at veere ca. en
time, hvorefter faleren fortaeller dig, at du
skal tage en pause.



SP14: Jeg kan ikke tage en pause nu, fordi jeg har
masser af arbejde. Hvad sker der sa?

Sv.:  Feleren har registreret, at du arbejder i mere
end én time. Nar du rejser dig fra stolen,

vil fgleren nulstille sig selv og vil genstarte
tidsteellingen igen, ndr den registrerer; at du

er i stolen igen. Pausen er til dit eget bedste!

SP15: Hvornér fungerer

strombesparelsesfunktionen?

Sv.. a. Bruger registreres i stol, skeerm fungerer
normalt.

. Hvis bruger ikke registreres i stol, vil
skaermens lysstyrke blive dempet efter 1
min. Energibesparelse.

. Skaerm slukker efter 3 min., og gar i
standby-tilstand og sparer strem.

. Bruger vender tilbage til stol. ErgoSensor
returnerer skaermen til normal drift med

det samme.

SP16: Hvordan er det anderledes fra min Philips
PowerSensor-skaerm!?

Sv..  ErgoSensor er en mere avanceret fgler, der
faktisk bruger en CMOS-foler, der genkender
personer og deres tilstedevaerelse eller
fravaer og er mere precis. PowerSensor
bruger infrarede signaler til at registrere
tilstedeveerelse eller fraveer og aktiverer sig

selv.

SP17: Kan jeg slukke for ErgoSensor?

Sv..  Ja

SP18: Kan jeg slukke for individuelle funktioner?

Sv.. Nej.

SP19: Kraves der softwareinstallation?

Sv.. Nej. Den findes i skaeermen. Du skal ikke

installere noget.
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SP20: ErgoSensor-modulet ligner et kamera.
Optager det noget? Kan nogen "se" mig
eller "spore" mig? Hvad med mit privatliv?

Sv.. Nej. Den kan hverken optage eller
kommunikere. Fgleren er et uathengigt,
hardwarebaseret CMOS-kamera med lav
opl@sning, der registrerer dig og sa bruger
kraftige algoritmer til at give dig korrigerende
rad. Den kan ikke overfere data til og fra

computeren.
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